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Abstract

This project is to supply multimedia technology entertainment activity.
It will display charecter in the form of karaoke and picture from video type at the same time

by using application software.
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1neé menu()e

{
116 sel, x,. 'y, count:
GrPix  color:

/* _(toad the font, if it has not been done yet */
i1 (text_setup == 0) | :
x = GrfontOpen ("sens.112, NULL. 8font_handie):
if (x>=0) |
x = GrFontioad(font_handle):
1 (x 2% 0) 1 )
GrBmSet (pBM, GrBrilextfont, font_handle);
. GrBmSet (pBMw, GrBrmlextfont, font hardle):
)
[
text_setup = 1;
, ]

/* Draw the menu ff that has not already been done o
if (menu_drawn == 0) |
/* Draw a.11ght blue background rectangle for the menu */
GrPixFromColor (p8M, GR_COIOK_RGB, 70. BS. 235, 8color);
GrBmSet (pBM, GrBmDrawColor, color):
GrBmSet (pBM, GrBmbrawQutiine, FA1SE);
GrRect (pBM, MENULX, 'MIN. Y, PNU_KIDIH, MINU_FIIGHT):
/* Draw a 2-pixe) wide yellow box arounc the menu *)
GrBmSet. (pBM. GrBmDrawColor, colorsil}): /= yellow */
GrBmSet (pBM, GrBmD-awlutYine, TRyl ):
“G-Rect (pBM, MENULX, MENU_ Y, MINU_WIDTH, MENU_HEIGHT); -
GrRect (pBM, MENU_X + 1, MIN®LY « ], MURG_MICTH - 2,
MENU_HEIGHT * 293

/* Set up the text to be transparent =/
GrB8mSet (pBM, GrBmTextBg, :ALSE):
\
/* Set up location to Craw tear from array: item[) =/
x = MINU_X 4+ 10;
y = MIND_Y + 4;

count = Q;
7* Draw ftems every 78 pircle, until a nul item */
whiie"(  (count < 24) 88 (-:tem{count) != (char) ' * ) ) |
if (count == 12) |
y #= 15;
A= MENU_X + 10;
)

é LY Al M
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» MIDIAscript™ Sample (ode
* [isplays motion viceo file in Window which mcves around

the screen

cls 1tblue

* load the "Actionmecia® image and get its background color
f actmedd 3
s dest=i:grab 1 1:s bkgnd=gcolor.dest=o

* copy it transparently to the screen

fct im 29 100

* lpad the arrays for the animations <<
{ array,colt0314/0,480 % i

* Now do four colt arimatiorns off screer
s dest=]

tashD seq im 128120 128 0 128 120
tash? seq im 128 120 0 120 128 120
tashd seq Ym 128 120 384 240 1728 120
tashd seq im 128 120 256 360 128 120

oo o
~NO NN

* Now arimate the moving windcw o the screen

s oest=0
6.2 M4 1= -2l 60/ 08 388 D126 yelow .
task] seg 0 O 5i1 480 1 120 62 280 384 120 0 2/r

* wait for & keystroke or click to end it
rouse
term '

A (3 ' a d' =
Ui 1.10 Mevrves TsuasuanFUATIdoudu MEDIA  script

The iiZ0 vhip ot
processes vlideo
digitally and
sends full-screes
full-frame rate

! video Lo the

i display. lesages

. may be

st yed with Y
graphics. y

Thix image Is being displayed
in a portiom of a 512 by 480
pixel screem, bul you may also
view a full-scieen motlon
video.

o,
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Templates

Action template 2

Your finished scene

Action! comes with a set of templates that you can use to create
professional-looking presentations right away. Templates are
ready-made scenes that contain objects, motion, transitions, and
text. To create your own presentation, just edit the text, replace the

graphics if necessary, and you're done!

PRV P rac A Ry T

= Action! - Untitled.ACT vjall
File Edit Control Window  Object Text Scene  Chan Help B
- B[ " b
YAl Glaglin]rIn]
Ol 0:.
ool Bullet Chart Title L @"'y
il R R TR R VT IR RS R e, ¥ et

s ohaA Ve b as &
PTG

@ Firstbullet sentence

€ Second bullet sentence

U_hird_bldlat_qemencn

Action! - Untitled ACT

File ~ Edit  Control Window Object Text Scene. Chan Help

g OUR NEW PRODUCTS!

R DT T e ot T s T S
PRI B T TR Y A g LN

AT

Ve s emen e b

Fun Fax/Fone
Cellular Commuter

Decidedly Different Desktop

®e © o o

Portable Pocket Printer

S

Ter}iplcfes let you use ready-made presentations.

Getting Started



Rewind . Ctriel
Backstep Ctris2

v Stgp Ctrie3
Sigp Ctris4
Play Ctri+5

East Forward Ctri+6

Zoom |n
Zoom Oyt
Set Loop...
Set Pagse...

vScene View
JTemplate View
Compressed View

Two ways to play a presentation

When you choose Play Presentation, the menu bar disappears and
Action! closes the Tool Palette and the Control Panel. The
presentation plays from beginning toend, using the full screen.

| | To stop the presentation at any time, press Ctri+3.

. Using Online Help

Action! comes with a context-sensitive Online Help system. You
can request help in two ways:

- Press Shift+F1 to get the help cursor, then choose any Action!
command to display a help screen describing that
command.
or

Getting Started
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Content List and
Scene Sorter

With the playback head at the tophof the Timeline, you can move
quickly to specific times in a scene. As you move the playback

head, the presentation window shows you the objects that appear
at that scene time.

Two other Action! features are useful for building and rearranging
scenes and combining them into a presentation. The Content List,
chosen from the Window menu, displays a list of all the scenes in
the presentation and all the objects in each scene. Use it to get an
overview of your presentation and to edit text objects in a scene.

e Content List -

=

=

o
>

A Annus! Meeting e
O Highlight underline
A Eclectic Electric
A November 29, 1991
# Restant
H Loco.oiB
2 [ Welcome
A Welcome to Chicagol
%2 Chicago, My Hometown
[ CHICAGO.MMM T .

> -

The Content List shows the objects in all scenes.

The Scene Sorter, chosen from the Window menu, shows an image
of each scene in the presentation. It also gives the name of each
scene and its associated template, what happens at the end of the
scene, and any sound that plays between scenes. Using the Scene

Sorter, you can easily rearrange scenes by dragging them to new
locations.

= Scene Sorter -
)5 1o S A
= u
—— "
LI | -
1 Tile 2 Welcome
01-INTRO Template 81
| = —
“II of =l T ellgs
3 Seles 4 Products
01-BAR 01-BLTS Y

The Scene Sorter shows the sequence of scenes.

Action! Concepts
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Click to go to
beginning of first scene.

Timeline

Playback head

= Action! - CAACTIONPRE SENTWEETING ACT

Eile Edit Control Yindow QObject Text Scene Chart Help

Annual Sales Meeting

o - LG SRR A ok g

Eclectic Electric
November 29, 1991 y

0 S W S T B 0 S A

- =

A button takes you to onother.loccﬂon in the presentation.

As you create objects in a scene, they appear in the presentation
window and in the Timeline, a window that shows how all the .
objects in a scene relate to one another. In the Timeline, each object
appears as a bar: the length of the bar shows the duration of the
object in the current scene. You can stretch or shrink an object’s bar
in the Timeline to increase or decrease the object’s duration, or

move the object to a different time in the scene,

j Timeline-

02| , 04} 06| 08]  10] 121 | . 16| 18] 3

The Timeline shows where and when an object appears in the scene.

Getting Started



= Action! - Untitied ACT ~]a

Eile Edit Control Window Object Iext Scene Chart  Help

Template object_____ |[= - 3 |
p LKL L3 13

i i R 0ws [

A Seem®___JD

SR RSN BN A BT T T R A S SRR A SR A AU S b

Scene objects

Template view icon Annual Meeting 11/29/91

Presentation window in template view

When you open an existing Action! presentation, you see the
presentation window in compressed view; that is, all the scene and
template objects are shown in their Hold positions. This view is
useful for aligning objects, changing Hold positions, and resizing
objects. When you're in compressed view, the com pressed view

r ~icon appears in each corner of the presentation window.

Working with Objects



Click to turn
Compressed view on
and off.

_Preferemcesri Jpi, C i

Default Object Duration: i A
@ D)iopen in Compressed View

Defautt Scene Length: O Load Templates in Compressed View
@@ Detault Number of Scenes: EE
Control Pane} Grid Dimensions
RewffF: @ Directty to StaryEnd [ Horiz: Vert E

O Muttiplier: E
Stage Size
Step Inuemenc milliseconds ,—Hﬂ"ll E Vert

Tab Eme@ spaces Lc.ﬂ&&ﬂ I_ oK —l !

4

Creating Objects

With the Action! Tool Palette, you can create text objects and six
types of drawn objects: rectangles, rounded rectangles, lines,
polygons, ellipses, and arcs. The Tool Palette also contains tools for
changing colors, patterns, and line widths, and for applying
action, sound, and links to pbjects. You create and edit scene
objects in scene view. You Create and edit template objects in
template view.

Pointer. {A Text
Rectangle—___ |[2] Polygon
~Rounded rectangle 3 O Elipse
o
A Chart
Colorchip —— Pattem sample
Linesample_____
Action
Sound—__ fg&
Link

Working with Objects



= Tip Use sound objects as a voiceover or to add background
sound to an entire scene. Assign sounds to objects to emphasize
specific information or to punctuate action in a scene. Because CD
audio sound requires no memory, it's an efficient way to import
sound that plays for more than a few seconds. Digitized sound,
which must be stored in memory, is more useful for shorter
sounds. ;

When two or more sounds overlap in'a.scene, the sound in the
frontmost layer takes precedence. For more information on
layering in Action!, see Chapter 4 and the Timeline command in

Chapter 6.
‘ To apply sound to an object,
L 1. Click the sound ool in the Tool Palette.
When you move into the presentation window, the pointer
changes into the sound cursor.
2. Click the object you want to apply sound t{o.

The Import dialog box appears.

ST mpont T

PP —

File Type: [ylunsoh WAVE WAV

File Neme: twnv

bells.wav cAaction\sound
clapping.wav
clock.wav |-
door.wav -2
engine.way [-b4)
fanfare.way 5]
gong.wav [-d
ohoh.wav
train.wav
1]

You can choose from the following sound file types:

. Windows Wave (WAV) digitized sound. ClipMedia
includes digitized sound you can use in your presentations.

* Microsoft MIDI (.MID) digitized sound.
* CD Audio from a compact disc in a CD-ROM drive.

40 Applying Sound to Objects

Ch



Setting sound
durations

Enter duration.

Click to cue a sound.

Click to repeat the sound.

42

Enter the track number and start and end times for the sound.
You can click a box and type in track and time numbers in
minutes, seconds, and tenths of seconds; type a track
number and use the slider to move to a speci’ic time in the
current track; or click the up and down arrows to set
duration.

It you're using the slider, tlick the Set buttons to enter the
Current time as the Start time or End time, then click OK. It
you've typed in the times, just click OK.

Action! returns you to the Sound Edit dialog box.

In order for a sound to play, you must give it a duration in the
Sound Edit dialog box.

e

* " ~iSound Edit TN

"

TENGREWAY 4= ] |

Duration:

H@ Egm

(Cue

w h

QO Enter Delay:

Enter value for delay.

O Hold By .
OExit 0 60
O Loop " Cantinue Inta Click to continue
Next Scene  4———sound
| [Preview][FGoncet || 70K ]

To set a duration for the sound,

16

Enter a time in the Duration box.

You can click a box and type in a duration in minutes,
seconds, and tenths of seconds; use the slider; or click the
up and down arrows to set the duration. The sound’s
duration doesn’t have to be the same as the object’s
duration. If it's shorter, the sound plays only part of the
time that the object is in the scene.

To hear the sound, click Preview.

Applying Sound to Objects



Importing movies

To keep a graphic’s original palette,

1. Click Use Palelte.
The palette is given a name that associates it with the
graphic. This palette is then available for use in any Action!
scene or template.

2: Click Import.
The graphic appears in the presentation window. Imported
graphics are given the default object duration set in
Preferences.

Action! allows you to import MacroMind Director movies as
objects in scenes and templates. Director movies are animations
created on a Macintosh computer.

Before you import the movie, it must be converted into a format
that can be played on the PC. This conversion is performed on the
Macintosh by the Gaffer, part of the MacroMind Windows Player
application. During conversion, the Gaffer appends the extension
.MMM to the movie name.

To import a movie, -

1. Choose Import from the File menu (or press Alt+F, ).
You can also click the action tool in any empty space in the
presentation window to import a movie.

The Import dialog box for movies appears.

" “Amport
File Type: ‘MncroMInd Director .MMM |£|
File Nome: | MMM ]
&
airport.mmm | ci\actionimovies

chicago.mmm T
compute.mmm| ..} | Import I

faxdemo.mmm| |[-a]

sanfran.mmm | {[-b]
el [0 Use Palette

kel

I_mporting Objects
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Changing colors
and patterns

Changes fill color.

Changes outline color

L] To change the border around the text, choose Border from
the Text menu (or press Ali+1, B), then choose a new line
width.

Once you change the text settings, the new settings remain in
effect the next time you create or edit text.

When you create an object, Action! fills it with the colors and
pattern indicated in the Tool Palette (text objects use the current
color). You use the color chip to change text and fill colors.

Note If your monitor is set to display 16 rather than 256 colors,
some colors in the palette are displayed as dithered halftones.
To change the fill color of an object,

5 Select the object and click the upper left comer of the color
chip in the Tool Palette to open the color paletie.

Al
= =3 =)
Djo olo

~]~ ™

= ]

EJ. (3] L1
E =n &
! sasssEents
= oE NREERN
& | 11 10 39
. L1t IED
o) O D S Drag o se'ect a new color.
slelsinlssisinin]
é’@ BERRERSCD
o D0C00203
{11 Fleluieiais]
EEQREREENS
BEREEZRER
EEREEERED -
24 Drag in the color palette to choose a new fill color.

Use the pattern sample to change an object’s fill pattern.

To change the fill pattern of an object,

1. Select the object and click the patiern sample in the Tool
Palefte to open the patiern palefie.

Editing Objects
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[E LS MO APV

<ol v SR

DI ROAgD 31 pea e

P T e

Drawn object

attributes

Button object

Ay e =

S R [po*cl:’rir";."f' LAl
f Resume j

— Content :
O3 o[ Comter g

Link
Duration

attributes

> Cancerrsi® | [ ~ox= %]

Use the Edit Object command when you want to make several

» changes to an object at one time. The following example shows

you the type of changes you can make using a few of the options
for a drawn object.

Suppose you‘ve drawn a hot air balloon, added action to the Enter,
Hold, and Exit phases of the object, and assigned a sound to the
object. You want to change all of these attributes and the color of
the balloon. Of course, you could use the tools in the Tool Palette
to change these attributes one at a time. But here’s how to use the
Edit Object dialog box to make these changes much more quickly.

Working with Objects
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